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Instructor's Notes

Planning the Document and Opening the Report

The case in this section gives students an idea how many people can work on a single document that will later be pulled into a single document.  The author will use the company’s guidelines to help her plan the report.  Many times students resist the planning process.  Explain that the planning process will actually save them time in that they will not have to make as many changes later on.

When they open the partial report, draw the attention to Figure 3-1.  Here, students will see the draft of the report with markups stating what changes and additions need to be made.
Setting Tab Stops
A tab is the space between columns of text or between the margin and text. The tab stop identifies the precise location where the text moves when you put a tab in front of it. The five major tab-stop alignment styles are left, center, right, decimal, and bar. The name of the tab-stop alignment style identifies where the text lines up to the tab stop.

Use Figure 3-2 to show the tab stop alignment styles.  Students sometimes have trouble understanding the different styles.  Be sure to cover and demonstrate the concepts thoroughly.  

Stress to students that in order to set tab stops in an existing document, they must select all the text for which they want to set the tabs.  Students who have not used tabs before might set the tabs on the horizontal ruler before selecting text; this will set tabs, but only for the line where the insertion point is currently positioned.  Also point out the way the tab alignment selector at the far left of the horizontal ruler works.  Although the tab alignment selector resembles a toggle button (i.e., the Italic button), toggle buttons only have two settings (either on or off), while the tab alignment selector has five different settings.  Because students might be used to the toggle buttons on the Formatting toolbar, if they need to position a left-aligned tab-stop marker, for example, they might recognize the left aligned tab stop marker (which is the default setting) on the tab alignment selector and be tempted to click it to turn it "on".  This, however, does not turn on the left-aligned tab-stop marker, but instead advances the selection to the next setting (the center-aligned tab-stop marker).  In light of this, it is also useful to make special mention of each of the tab-stop markers so that students begin to recognize each of the markers as they appear in the tab alignment selector.

By default, Word's tab-stops are set at every one-half inch. Use the horizontal ruler to select and move existing tab stops. Explain to students that to set new tab stops, click the tab alignment selector until the style you want is displayed and then click on the horizontal ruler to set the tab. To remove a tab stop, drag it off the horizontal ruler. 

Formatting the Document in Sections
A section is a unit or part of a document.  This is an important concept in Microsoft Word.  Emphasize that each section of the document becomes almost a separate document.  When you make a document-level formatting change, you can tell Word that you want the change to apply only to the section, not to the entire document.

Use Figure 3-7 to show the different types of breaks that can be entered into the document.  Point out the four different sections breaks.  Have students think about when they would use each kind of section break.  It is particularly important that they understand the difference between a Next Page section break and a Continuous section break.  

A section break identifies where one section ends and the next section begins. Section breaks should only be inserted when you want to change a feature that can be unique to each section. These features are the page orientation, margins, headers, footers, and vertical alignment. For example, in a long document, you can add section breaks between chapters when you want to change the name of the chapter in the header or footer. In business documents, you can change the page orientation to landscape to display a wide table.

An important use of sections is in creating different headers and footers for different sections.  For example, if you have a document comprised of three chapters, you might want the chapter number and title in a header.  Thus you would divide the document into at least three sections, one for each chapter in your document.  Then, when you create a header, it will apply only to the current section (that is, the current chapter), unless you specifically indicate that you want to use the same header as in the previous section.

Quick Quiz
1. Which of the following is NOT a tab stop alignment style? (Answer: b)
a. Center

b. Justified

c. Right

d. Bar

2. If you want a section break but you do not want the section break to begin on a new page, you would choose a(n) _____ section break. (Answer: continuous)
3. True/False: A Hanging Indent tab indents every line of a paragraph except the last one. (Answer: False)
Changing the Vertical Alignment of a Section
Explain to students that the vertical alignment identifies where text is displayed between the top and bottom margins. The vertical alignment options are flush at the top, flush at the bottom, or centered. The most common vertical alignment is flush at the top, but you might want to change it for a specific page. To change the vertical alignment for part of a document, that part must be in a separate section. To change the vertical alignment, select the Page Setup option from the File menu. Click the Layout tab and select the type of vertical alignment.

Center a page between the top and bottom margins

Explain to students that there are several reasons you might want to center text between the top and bottom margins. Title pages, stand-alone graphics or tables in a business document, and brief letters are good candidates for centering text vertically. If the page you want to center vertically is part of a longer document, make sure that the page is in a separate section.

Adding Headers
Make sure that students understand that text printed at the top of every page is a header. Text printed at the bottom of every page is a footer. Word has great flexibility in handling headers and footers. You can specify unique headers and footers for the first page of a document, for even and odd pages in a document without sections, for each section, and for even and odd pages within sections. Specifying different headers and footers for even and odd pages enables you to place items like page numbers on the outside margin of every page. Specifying different headers and footers for each section enables you to include items that change, such as chapter titles, in the header or footer. You can even have some pages with a header and some pages without, such as a title page.

It is a good idea for students to view the headers and/or footers in Print Preview so that can see how these are going to look when the document is printed.    Remind students that, in order to have different headers and/or footers on different pages, they will need to divide the document into sections.

Classroom Activity

Divide your class into groups of two or three.  Have each group consider a situation where they are writing a document that will later be published as small booklet (perhaps a handout for a board meeting).  The document will be copied on both front and back of the paper and will be bound in the middle (like a book).  Ask the groups to consider how sections will help them create the title page, the headers, and the footers.  Explain that the title page will be centered both horizontally and vertically and will have no header or footer.  However the remainder of the pages will not be centered but will have a header and a footer.  Explain further that the pages on the left side of the booklet will have a header that shows the booklet title on the left side and a footer that has the page number on the left side.  Alternately, the pages that will be on the right side will have a header which has the title of the booklet on the right side and a footer that has the page number on the right side.  Ask each group to consider how they will accomplish this.  After a few minutes have the groups share with the class what they have decided. 
Inserting Tables
A table organizes information into horizontal rows and vertical columns. This makes the information easier to read and understand. To display a large amount of information in columns, a table is easier to organize and edit than columns created with tabs. You can create tables in two ways: (1) Create a blank table and insert text into it; (2) Convert existing text into a table.

Go over Figure 3-14 with students explain the different elements of a Word table.  Ask students if they have ever used Excel.  The students who do have experience with Excel can relate to the concept of a cell.
To enter text into a table, simply move the insertion point to the correct cell and begin typing. Word will automatically wrap the text to the next line in the same cell and increase the height of the cells in the row. Continue moving the insertion point and entering text to complete your table.  Remind students that after entering text in a cell, they should press the Tab key (not the Enter key) to move to the next cell to the right (or from the last cell in a row to the first cell in the next row).  Pressing the Enter key starts a new line within the cell.  To delete a new line, press Delete, just as you would within a normal block of text.

Displaying the Tables and Borders Toolbar
Whenever you have a table in a document, displaying the Tables and Border toolbar provides an easy way to work with the table.  In this tutorial, they don’t use the tools on the toolbar very much, however, you should help them become familiar with the toolbar.  Be sure to have them hover their pointer over each tool on the toolbar and read the tooltip.  
Sorting Rows in a Table
You can sort, or arrange, the rows in a table based on the contents of one of the columns. Rows can be sorted in ascending or descending order based on alphabetical, numerical, or chronological criterion.

While all of the sorting options that are available with a spreadsheet or database program are not available in a Word table, basic sorting functions can be performed.  The Sort buttons on the Tables and Borders toolbar provide easy access to the sorting function.  The terms ascending and descending may be new to students.  Be sure to define them for students, so that they can associate requests for each type of sort with the appropriate Sort button on the Tables and Borders toolbar.

Modifying an Existing Table Structure
Recommend to students that they familiarize themselves with the ways to insert or delete table rows and columns.  This will save students a lot of time.  As with many features in Word, several of these methods for restructuring a table can be performed in more than one way.  Make sure students understand how rows, columns, and end-of-row markers are selected; otherwise, they will not be able to perform many of the table insertions and deletions discussed in this tutorial.  Use Figure 3-23 to cover the various ways to insert and delete table rows and columns.
Explain that rows can be added between existing rows or at the end of a table. Columns can be added between existing columns or at the end of a table. Individual cells can be deleted, merged, and split. You can delete the content of a cell or the structure of the cell. Merging cells removes the border between the cells. Splitting cells creates multiple rows or columns.

Quick Quiz

1. In a table, the area where a row and a column intersect is called a _____. (Answer: b)
a. Row

b. Cell

c. Column

d. Field

2. In Word, a tables structure is shown by _____. (Answer: gridlines)
3. True/False:  The lines that print along the side(s) of a table cell are called gridlines. (Answer: false)
Formatting Tables
The best way for students to understand the table formatting features described in the tutorial is to experiment with them.  Some features, like changing column width and row height using the mouse pointer to drag column row borders, require some getting used to, as students first have to learn to identify the special pointer for the task and then carefully drag the border (perhaps using the Alt key) to the desired location.  Encourage students to explore these options, remembering that they can always use the Undo button to restore a document to its original state immediately after making an undesirable formatting change.

Some helpful hints you may want to share with students as they learn to work with adjusting column widths are:

· You can adjust column widths manually by dragging the column boundaries or by dragging the column markers on the horizontal ruler.

· If you adjust column widths manually, always start at the left-most column and work your way to the right.  (If you start on the left, and work your way right, the column to the right of the one you change will also change.)

· If you want to move the column boundary for the entire table, drag a column boundary line or, even better, the column markers on the horizontal ruler.  Make sure no cell or row is selected.
· If you want to move the column boundary in just one row, select that row then drag the column boundary or the column marker.

· If you want to move a single column boundary, without affecting the location of the other column boundaries, select a column to the left or right of that boundary, then drag the boundary line or the column marker.  While dragging, the other column markers of the table might move, but when you release the mouse button, the boundary that you moved will stay where you dropped it and the other boundaries will jump back to their original position.

· If you want to know the column widths as you move the column boundaries, hold down the Alt key as you drag the column marker.  The width of each column will appear on the horizontal ruler.

There are many ways to improve the visual appeal of your tables while making them even easier to understand. You can adjust the size of the rows and columns, change the text alignment, modify the borders, add a shaded background, and rotate the text inside a cell.

Adjust the size of the rows and columns in print layout view so you can take advantage of the vertical and horizontal rulers when you drag the borders to new locations. Aligning text, such as numbers or headings, in the cells makes the data easier to compare or understand. Borders can draw attention to important data or enhance the table's appearance. Shading highlights important items such as headings or totals. Text can be rotated within a cell, but use this feature cautiously. It can make the text more difficult to read, detracting from your table's appearance and functionality. Finally, the alignment of the entire table within the margins will affect the table's appearance and impact.

Also take time to explain the difference between the use of the Center button on the Formatting toolbar and the Center Alignment option on the Table tab in the Table Properties dialog box.  One way to ensure that students understand how each of the different formatting features is applied is to present them with a fully formatted table with each of the different formats (i.e., rotated text, left/center/right-aligned text, thick borders) marked, and challenge them to describe the steps through which each formatting option was achieved.

Changing Borders

Be sure students understand the difference between the borders (printed lines) and the gridlines (non-printed line) in a table.  In order to see the table while editing, you need to be able to see where the cells are in the table.  However, you might not want those lines to show when the document is printed.  Often users will use a table to help them align elements of a list.  Then, the borders are removed so that the list does not look like a table at all (even though it is, in actuality)

If the border will be shown, the user may want to alter the width and style of the border.  There are several different options for this available on the Tables and Borders toolbar.
Adding Shading

Shading provides additional visual appeal and emphasis to a table.  However, remind students that they can only print colored shading if they have a color printer.  If they will print to a black & white printer, they should stick with the shades of gray shown in the shading list.
Centering a Table

It might be desirable to center a table vertically, horizontally, or both.  To center a table horizontally, you must first select the table.  Use Figure 3-32 to show the alignment properties of a table.  Explain that this applies to the table itself, NOT the values in the table.

 The book shows the process of using the Table Properties dialog box.  However, you might explain that you can also select the table (click Tables on the menu bar, Select, table) and then click the Center button.  

Quick Quiz

1. The background color of a table is called   _____. (Answer: c)
a. Background


b. Gray 

c. Shading

d. Fill

2. You can modify an existing border by changing is line weight or its _____. (Answer: line style)
3. True/False:  In order to center a table, you must click a single column and then press the Center button on the Standard Toolbar.  This process must be repeated for each column. (Answer: False)
Classroom Activity

In groups of two or three, have students consider all the formatting options that have been presented in this tutorial.  Have each group think of an example of data that they might want to place in a table.  Have students, then, consider what kind of shading, borders, and justification they would choose for that table.  As they make their decisions ask students to consider whether there are times when formatting a table could be taken too far to the point of being distracting to the person reading the document.
Reviewing a Document in Reading Layout View

This is a new feature with this version of Word.  In the Reading Layout View you can see the document as it would appear on a page.  It is similar to the Print Preview.  The difference is that you can actually work on the document in Reading Layout View.  This is a great way to view the document as it will be printed.
Tutorial Discussion Questions

1. Why is it important to plan out a document before you begin?  How could this process help you save time in the long run?

2. Think of an example where you would want one header on certain parts of a document but a different header on other parts of a document.

3. One of the ways that section breaks can be useful - for setting different headers and footers - is discussed in this tutorial.  What other situations can you think of in which having a document divided into sections would be useful?  How would it help?  Are there any disadvantages to dividing a document into sections?

4. Think of something you have typed recently (for school, perhaps) that you could have used a table had you know about them.  What would the table look like? Would you have borders or not?  

5. What is the purpose of formatting a table in different ways?  Can too much formatting (i.e., many different fonts) be a bad thing?  How can you judge when you have a table "right"?

Key Terms

	Term
	Definition

	Border
	A line that prints along the side of a table cell

	Cell
	The area where a row and column intersect (in a table)

	Footer
	Text that is printed at the bottom of every page

	Gridlines
	Lines that show the tables structure

	Header
	Text that is printed at the top of every page

	Heading row
	The top row of the table that identifies the type fo information in each column

	Line Style
	The look of the border (dotted, dashed, etc.)

	Line Weight
	The thickness of a border

	Reading layout view
	A view that allows you to peruse a document quickly, displaying the entire content of a page in a single screen, in a font that is large enough o read easily.

	Section Break
	A dotted vertical line that marks the point at which a one section ends and another begins

	Shading
	A gray or colored background (in a table)

	Tab
	Adds space between the margin and text in a column or between text in one column and text in another column

	Tab Stop
	The location where text moves when you press the Tab key

	Table
	Information arranged in horizontal rows and vertical columns

	Tables and Border toolbar
	A toolbar that contains a number of useful button that simplify the process of working with tables

	Tab-stop alignment styles
	Styles that determine how text will be aligned on a tab stop.  These include Left, center, right, decimal and bar alignments.

	Vertical Alignment
	Specifies how a page of text is positioned on the page between the top and bottom margins



Page 1 of 9

